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Introduction

Each system will be provided with its own User Guide, Quick Reference Guide and if needed, an
installation manual. This document is quick reference handbook for basic troubleshooting to ensure to
have same understanding of basic troubleshooting method on Cisco TelePresence Infrastructure
Product.




Information on service request

To ensure Cisco TelePresence TAC to assist technical service request and provide quick resolution,
TelePresence TAC require a minimum amount of information for each service request.

When reporting the technical service request, please ensure:

» Describe in detail about problem/issue

» Describe how often the problem occurs

» Describe the latest operation before problem occurs, if any

» Describe in detail, procedure to recreate the problem, if any

» Describe in detail, which steps have already been taken in investigating the problem
» Describe the equipment used and the system serial number (from all sites involved)
» Describe the software version of system (from all sites involved)

» Logs from system including configuration and system status




Terminal software for TelePresence
Infrastructure

Important: Please start the log capture from all systems involved in the call before calls/conferences
are started so we capture all the call setup process and ensures that all output is logged to a file so
none is lost.

There is multiple terminal software that may use for retrieving the log from system:

Windows HyperTerminal (Serial, Telnet)
Can be found under: Start Menu — All Programs — Accessories — Communications —
HyperTerminal.
The Windows Hyper Terminal supports the Telnet protocol only. Please remember to enable
the Capture Text option (menu “Transfer” — “Capture Text”).

TeraTerm
Down load the TeraTerm installation file from http://sourceforge.jp/projects/ttssh2/releases/
Supports multiple Protocols, including Telnet and SSH which are the two relevant protocols for
the TelePresence Endpoint portfolio. It will automatic detect serial port if you are using USB to
serial converter and option for save log with time stamp.

Putty (Serial, Telnet, SSH)
Download the Putty installation file from
http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

Supports multiple Protocols, including Telnet and SSH which are the two relevant protocols for
the TelePresence Endpoint portfolio.




Terminal software for TelePresence Infrastructure

How to use Windows Hyper Terminal

This following page explains how to use Windows Hyper Terminal.
Please note, Windows Vista and Windows 7 may not have Hyper Terminal installed on default setting.

1. Start Hyper Terminal: Start Menu — All Programs — Accessories — Communications —
HyperTerminal Supports the Telnet protocol only.

2. Under “Connect using” select “TCP/IP (Winsock)” and enter the System IP address.
Connect To @
% Appendix demo

Enter details for the host that you want to call
Host address: 1 10.0.0.30

Port number: |23

Connect using: | TCP/IP (Winsock) v

| OK ” Cancel l

3. Default password is cisco, TANDBERG or blank unless changed. Some Infrastructure
products have “admin” or “root” as login name.

4. To save retrieve logs: Enable the Capture Text option (menu “Transfer” — “Capture Text”), and
save it as a *.log file.

5. Type in the respective commands described in Appendix.
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Terminal software for TelePresence Infrastructure

How to use TeraTerm

This following page explains how to use TeraTerm.

1. Start TeraTerm: Start Menu — All Programs — TeraTerm Pro with TTSSH2 — TeraTerm Pro (if
install software as default setting).

2. Select “Telnet” and enter the System IP address in “Host”.
(Or select “SSH” and enter the System IP address in “Host” in order to establish SSH
connection between systems.)

Tera Term: New connection @

@ TCPHP Host: 7
History
Service: O Telnet
@ 8SH SSH version: SSH?
O Other

TCP port#: 22

Protocol: UNSPEC +

O Serial

I 0K f ’ Cancel I [ Help ]

3. Default password is cisco, TANDBERG or blank unless changed. Some Infrastructure
products have “admin” or “root” as login name.

& 10.91.8.103:23 - Tera Term VT
B [ o Crid Wedw Hep

elcone to Dharmesh.Handoria.0ffice &
AMDBERG Codec Release ES.3 PAL
SV Releasze Date: 2006-14-12

Passuord:

v

4. To save retrieve logs: Select “Log” from File menu and select location of saving file and file
name. You may check “Timestamp” option which will add timestamp on log base on PC’s
clock information.

(Example of timestamp format on log: [Wed Feb 25 15:10:30 2009]).

Tera Term: Log E|E|

Savein: | (£ 1S500052976-0cs ¥ O ¥ E° M-

= configuration,ml
= status123.xmi

= status.xml

5] syslog sds. TXT
P_',I teraterm.log

File name: teraterm. log

Save as type: | AN v Cancel

Option
[Cginary [¥] append [ Blain text

5. Type in the respective commands described in Appendix.
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Terminal software for TelePresence Infrastructure

How to use Putty

This following page explains how to use Pultty.

1. Start Putty

2. Select “Telnet” and enter the System IP address in “Host Name”.
(Or select “SSH” and enter the System IP address in “Host Name” in order to establish SSH
connection between systems.)

Category: .
| = Session | Basic options for your PuTTY session
T L_oglging Specify the destination you want to connect to
= 1emina
Keibaad Host Name (or IP address) Port
Bel J0OK X0 300¢ 30X 22
Features Connection type:
= Window ORaw O Telnet ORlogn & SSH O Senial

Annazranca
3. Default password is cisco, TANDBERG or blank unless changed. Some Infrastructure
products have “admin” or “root” as login name.
4. To save retrieve logs: Select “Logging” and choose “All session output” and select location of
saving file and file name at “Log file name”.

ﬁ-':_?.—t onnguranol In.__.:J
Catogory:
=) Session Options controlling session logging
Logging
= Teminal Session logging:
Keyboard O None O Printable output
Bel @QAMisessionotpd> O SSH packets
Features (O SSH packets and raw data
= Window Log file name:

Appearance VCS_8Y-8M-3D_&T log

Behaviour
(Log file name can contain &Y, &M, &D for date. &T for

Translation s
i time, and &H for host name)

5. Type in the respective commands described in Appendix.
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File transfer software for TelePresence Infrastructure

File transfer software for TelePresence
Infrastructure

There is multiple file transfer software that may use for retrieving the log from system or/and uploading
file to system:

Command Prompt
Can be found under: Start Menu — All Programs — Accessories — Command Prompt.

Command Prompt support ftp base file transfer between local PC and TelePresence
Infrastructure.

WinSCP
Download the WinSCP installation file from http://winscp.net/eng/index.php

Support SCP protocol with GUI for Windows base PC which use for safely copying of file
between local PC and TelePresence Infrastructure.
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How to use Windows Command Prompt

This following page explains how to use Command Prompt for ftp.

1. Start Command Prompt Hyper Terminal: Start Menu — All Programs — Accessories —
Command Prompt (or Start Menu — Run - type “cmd” and click “ok”)

Mi

4

er C:AWINDOWS\system32\cmd. exe

ik Mt

J

2. Navigate location for saving download file or file folder which to upload to system by using “cd”
command.
For example, save the download log to log folder under C drive on PC, “cd C\log”.

3. Establish ftp connection by using “ftp <ip address>" command.

4. Default password is cisco, TANDBERG or blank unless changed. Some Infrastructure
products have “admin” or “root” as login name.

5. Basic command which will use on ftp session

o

O O O O

o

Is — list the file directory

cd <foldername> - navigate to specified directory/folder
hash - Toggle printing “#” for each buffer transferred

bin — set to binary transfer mode

get <filename> — download specified file from codec to PC
put <filename> — upload specified file to codec from PC

6. Type “bye” to terminate ftp session between codec and PC




File transfer software for TelePresence Infrastructure

How to use WIinSCP

This following page explains how to use WinSCP

1. Start WinSCP: Start Menu — All Programs — WinSCP — WinSCP (if install software as default
setting).

2. Select “SCP” as Protocol, enter the System IP address in “Host name”, “root” in “User name”
and system password in “Password”.
Default password is cisco, TANDBERG or blank unless changed.

e
WinSCP Login 2
Session Session
Stored sessions Hosthame: P
Environment
Directories 19216801| 22
S5H
Preferences User name: Password:
root (1111
Private key file:
Protocol
File protocol: sSCoF -
Select color
[ Advanced options
About._. ] [ Langusges J [ Login J [ S J [ J
L

3. After verifying the information click on “Login”.
If the error message below appear during the connection process, just click “OK” and proceed.

Q Emor looking up user groups

4. Find the log file that would like to retrieve from right side of GUI windows and drag it to left
side of GUI windows which is your local PC

By Intal - root@ - WinscP (= ) |
Local Mark Fles Commands Session Options Femote Help
O lD-mEeES BRI Cijc Default - i
& C: System LRI T G5 A E T | Jtendey -& MEMD
Name  Ext Sze Type Changed /| Name  Ext Sge Changed Rights
L. Parert direct... &9/2010.. | & 12/5/2010 8:...  rwaerrx
|, ExtremeGraphics 7l .. 6972010, 13/5/2010 81, PWOEeeeee
)i Logs I74 T4 &9f2010.. i 10/8/2009 1:...  TWC--wres
o rerminfo 12/5/2000 81, PWoTWoInW
. app L1/172010 L., rwoer-xr-x
s Corts 11/2/I010 6., rwoer-xr-x
)i crash 12/5/2000 8:...  rwsorwaorvat (= |
. threctorypolicy 12/5/2010 8:...  rwoer-xr-x
. Bt 12/5/2000 8:...  rwoer-xr-x
images 12/5/2010 8:...  rweer-xr-X
i 1222010 5...  rwoer-xr-x
Jilog 12/5/2010 8:..,  rwoer-xr-x
| lost+ found 12/5/2010 8. (WiKweeee
rmanagement 12/5/2010 8:...  nrwser-xr-x
| pergstent 1/26/2011 10... nweorwor-x
|, provisioning 11/19/2010 6., rwner-xr-x
L. provey-registration TI&2009 7:1...  rweer-xrex

thl 13/1/2010 4:...  rwear-xr-x T
. ||« m '

OB of0Bn 0ol

OB ofS365 Bin Dofl

o F7 Create Directory »

AL F10 Quit

5 soP oo
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Sniffer software for TelePresence Infrastructure

Sniffer software for TelePresence Infrastructure

Important: Please start the log capture from all systems involved in the call before calls/conferences
are started so we capture all the call setup process and ensures that all output is logged to a file so
none is lost.

There is multiple sniffer software that may use for retrieving the log from system:

Wireshark (IP packet sniffer)
Download the Wireshark installation file from http://www.wireshark.org/download.html

Wireshark is the network protocol analyzer, and is standard across industries.
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RS-232 Serial Connection

Most of TelePresence Infrastructure has the D-Sub 9 pin data port on the back of the unit that may be
used for configuration and administration. The data port may also use for initial configuration. Software
upgrades may also be monitored via the serial ports.

Any RS-232 emulation can be used, such as Microsoft HyperTerminal, TeraTerm, etc. The default
connectivity parameters are:

Model Parameter
Baud Rate 115200 bps
Data Bits 8
Gatekeeper Parity None
Stop Bits 1
Border Controller Flow Control None
Interface D-Sub 9 pin interface on front of unit
Note Require reverse cable/adapter
Model Parameter
Baud Rate 115200 bps
Data Bits 8
Parity None
Stop Bits 1
Flow Control None
Video Interface RJ45 interface on front of unit
Communication
Server (VCS) Note Require.RJ45—D—Sub9pin cable for console
connection.
_Male RJ45 pin | Female DBI pin
1 8
2 3
Pin 3 XD 2
Assignment g g:g :
B RXD 3
¥ 4
8 7
Model Parameter
Baud Rate 9600 bps
Data Bits 8
Classic MCU Parity None
ISDN Gateway Stop Bits 1
Flow Control None
Interface D-Sub 9 pin interface on back of unit




Model Parameter
Baud Rate 9600 bps
Data Bits 8
Parity None
Stop Bits 1
Flow Control None
) _ Interface RJ45 interface (COM1) on front of System Control
Media Processing Blade
System (MPS
y ( ) Note Require RJ45-D-Sub9pin cable for console
connection
1 DCD
2 RTS
Pin 3 GND
Assignment L -
B GND 5
7 CTS
8 DIR
Model Parameter
Baud Rate 38400 bps
Data Bits 8
TelePresence
Server Parity None
Stop Bits 1
TelePresence
MCU Flow Control None
Interface RJ45 interface on front of unit
TelePresence
ISDN Gateway Note Require_RJ45-D-Sub9pin cable for console
connection
TelePresence IP ole
8
Gateway 2
Pin 3 XD 2
IPVCR Assignment o :
B RXD 3
4
7




How to capture a log from TelePresence Video
Communication Server (VCS)

Important: Please start the log capture from all systems involved in the call before calls/conferences
are started so we capture all the call setup process and ensure that all output is logged to a file so
none is lost.

This chapter explains how to capture the complete log file available for TelePresence Video
Communication Server (VCS). The table below lists the commands needed for the Cisco
TelePresence VCS. Please type all commands in the same Telnet/SSH session.

All retrieved logs should attach to ticket including a description and compress multiple attachments
into one file.

IP issues (H323/SIP)
Commands in bold

e Open the console/telnet/ssh session with VCS

[ ]

. (X3.x or prior software version, please use “ )

e Make a call and keep running until you have recreated the problem
e Hang up call

[ ]

(X3.x or prior software version, please use “
Don't worry that the screen is scrolling, just type in and press return to stop the netlog output

e Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file.

Reboot Issue
Commands in bold
e Open Web interface session with the VCS
e (o to the System snapshot page on the VCS (Maintenace > System Snapshot)
e Click Create system snapshot
Note: The system snapshot may take several minutes to be created, and will be large file. Once
the snapshot has been created a pop up box will appear request location to save the file to.

e Go to Incident reporting page on VCS (Maintenace > Incident reporting > View)

Note: Restart an incident report should be generate and will be avaliable for download from this

page

e Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file

Sniffer the packet on VCS
Note: This method should only use when request by TelePresence TAC.

Important: This works on both H.323 and SIP call, however it must disable encryption. For SIP,
make sure not to use TLS for signaling.

Commands in bold
¢ Open the console/ssh session with VCS and login as “root” user

Make a call and keep running until you have recreated the problem




e  Open WInSCP and retrieve the sniffer log under /mnt/harddisk/temp directory.
Important: Tracing log MUST delete as temp folder has limited desk space and not design to
capture log.

e Attach file to the ticket after zip compress it — Remember to name these or include a
description and compress multiple attachments into one file

Note: if for short sniffer, following step will also works.
Open the console/ssh session with codec and login as “root” user

[ ]
[ ]
e Make a call and keep running until you have recreated the problem
]

Open WInSCP and retrieve the sniffer log under /tmp directory.
Important: Tracing log MUST delete as tmp folder has limited desk space and not design to
capture log.

e Attach file to the ticket after zip compress it — Remember to name these or include a
description and compress multiple attachments into one file

Default factory VCS
Commands in bold
e Open the console/telnet/ssh session with VCS
o Take backup of system configuration and option keys

[ ]

Note: DefaltValuesSet will not add the default links with which the system ships from the factory.
The DefaultLinksAdd command will configure back default link between default zone/subzone.
Note: The certificates and policy files are not removed.

e Open the console/telnet/ssh session with VCS

Reset Password on VCS

Commands in bold

Connect serial/console connection

Restart the GK/BC

Login with the user name . No password is required.
You will be prompted for a new password.

B COMB:115200baud - Tera Term VT

Ble Edt Setup Control Window Help

ITANDBERG BC login: PWREC

ngg&gngmun‘b. ¥OU WILL BE PROMPTED FOR A PASSWORD TWICE
P z

IPLEASE RETYPE PASSWORD:

WELCOME T

ITANDBERG BORDER CONTROLLER RELEARSE Q5.2
:‘. RELEASE DATE: 2007-86-22
0

OK

IWRITING PASSWORDS THROUGH TAMDBERG APPLICATION FAILED.
IRESTORING PASSWORDE TO PASSWORD FILE DIRECTLY. TO ALLOW
IMANUAL RECOUERY PROCESS.

ANDBERG BC login:

Note: The PWREC account is only active for one minute following a restart. Beyond that time you
will have to restart the system again to change the password. Because access to the serial port
allows the password to be reset, it is recommended that you install the GK/BC in a physically
secure environment.

Revert back previous software version on VCS
Commands in bold

e Connect serial/console connection

e Restart the VCS




How to capture a log from TelePresence Video Communication Server (VCS)

e Press ESC to skip memory test

B COM7:115200baud - Tera Term VT

Fle Edt Setup Control MWindow Help

Phoenix - AwardBIOS v6.BBPG
Copyright <(C> 1984-28086. Phoenix Technologies, LID

(GB83-B25>NSB-1883 Series BIOS V1.8

Main Processor : Intel(R)> 2.12GHz(265x8.8>
Memory Testing :  S8528BKEOK+ 8M shared memory

Press DEL to enter SETUP ESC to skip memory test )
rs/aaxzm-:%s-um'uz GB83=:

e Wait for following screen.

B COM7:115200baud - Tera Term VT

Fie Edt Setup Control Window Help

GNU GRUB wversion 8.97 <637K lower ~ 3397584K upper memoryd

TANDBERG image 1
TANDBERG image 2
Hemtest86

b o ae ae on o an an 5 as an am = §

|
i
|
i
H
H
|
H

Use the = and v keys to select which entry is highhghtad.
Press enter to bhoot the selected 0S5, ‘e’ ed
commands before booting. or ‘¢’ for a comnd lins.

“

e Select non-highlight “TANDBERG image x” by using arrow up / down key and then press

enter key. VCS will start up with previous install software version.
Note: This software select menu will be available for 3 seconds only.

Cisco TelePresence Solution Support — TelePresence Infrastructure Handbook
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How to upgrade TelePresence Video
Communication Server (VCS) software

This chapter explains how to upgrade TelePresence VCS by using SCP software for in case of
problem with upgrading software from WebGUI or TMS.

Commands in bold
e Upload the release key file using SCP/PSCP to the /tmp folder on the system.
Example:

or

e Enter password when prompted
Type password in “Password:”. Default password is cisco or TANDBERG unless changed.

e Copy the software image using SCP/PSCP.
Note: SW file name should rename to “tandbergimage.tar.gz” before upload it to /tmp.

Example:
or

e Enter password when prompted
Type password in “Password:”. Default password is cisco or TANDBERG unless changed.

e Wait until the software has installed completely
¢ Reboot the BC/GK manually from Web GUI, from telnet session, etc.

Note: You may upgrade SW similar way by using WinSCP application as well.




How to capture a log from Gatekeeper (GK) and
Border Controller (BC)

Important: Please start the log capture from all systems involved in the call before calls/conferences
are started so we capture all the call setup process and ensure that all output is logged to a file so
none is lost.

This chapter explains how to capture the complete log file available for Gatekeeper (GK) and Border
Controller (BC). The table below lists the commands needed for the GK and BC. Please type all
commands in the same Telnet/SSH session.

All retrieved logs should attach to ticket including a description and compress multiple attachments
into one file.

IP issues (H323)
Commands in bold
Open the console/telnet/ssh session with GK/BC

Make a call and keep running until you have recreated the problem
Hang up call

Don't worry that the screen is scrolling, just type in and press return to retrieve system status
log

e Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file.

Reboot Issue
Commands in bold
e After GK/BC restart open the console/telnet/ssh session with GK/BC

e Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file

Sniffer the packet on GK/BC

Note: This method should only use when request by TelePresence TAC.
Important: This works on H.323 call, however it must disable encryption.

Commands in bold
Open the console/ssh session with codec and login as “root” user

Make a call and keep running until you have recreated the problem

Open WInSCP and retrieve the sniffer log under /tmp directory.
Important: Tracing log MUST delete as tmp folder has limited desk space and not design to
capture log.

e Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file




Default factory GK/BC

Commands in bold

Open the console/telnet/ssh session with GK/BC
Take backup of system configuration and option keys

Note: DefaltValuesSet will not add the default links with which the system ships from the factory.
The DefaultLinksAdd command will configure back default link between default zone/subzone.
The certificates and policy files are not removed.

Open the console/telnet/ssh session with GK/BC

Reset Password on GK/BC
Commands in bold

Connect serial/console connection

Restart the GK/BC

Login with the user name . No password is required.
You will be prompted for a new password.

B COMB:115200baud - Tera Term VT
e Edt Zetup Control Window Help

:I:HDHEHG BC login: PW

REC
nggﬁgngmlﬂl’:‘b. ¥OU WILL BE PROMPTED FOR A PASSWORD TWICE
léEnSﬁERéT!PE PASSWORD =

ANDBERG BORDER CONTROLLER RELEASE Q5.2
a RELEASE DATE: 2087-06-22

K

RITING PASEWORDE THROUGH TANDBERG APPLICATION FAILED.
ESTORING PASSWORDE TO PASSWORD FILE DIRECTLY. TO ALLOW
ANUAL RECOUERY PROCESS.

ANDBERG BC login:

Note: The PWREC account is only active for one minute following a restart. Beyond that time you
will have to restart the system again to change the password. Because access to the serial port
allows the password to be reset, it is recommended that you install the GK/BC in a physically
secure environment.




How to upgrade Gatekeeper (GK) and Border
Controller (BC) software

This chapter explains how to upgrade GK/BC by using SCP software for in case of problem with
upgrading software from WebGUI or TMS.

Commands in bold
e Upload the release key file using SCP/PSCP to the /tmp folder on the system.

Example:
or

o Enter password when prompted
Type password in “Password:”. Default password is cisco or TANDBERG unless changed.

e Copy the software image using SCP/PSCP.
Note: SW file name should rename to “tandbergimage.tar.gz” before upload it to /tmp.

Example:
or

e Enter password when prompted
Type password in “Password:”. Default password is cisco or TANDBERG unless changed.

Wait until the software has installed completely
Reboot the BC/GK manually from Web GUI, from telnet session, etc.

Note: You may upgrade SW similar way by using WinSCP application as well.




How to capture a log from TelePresence MCU
and IP/ISDN Gateway

Important: Please start the log capture from all systems involved in the call before calls/conferences
are started so we capture all the call setup process and ensure that all output is logged to a file so
none is lost.

This chapter explains how to capture the complete log file available for TelePresence MCU and
IP/ISDN Gateway Components.

All retrieved logs should attach to ticket including a description and compress multiple attachments
into one file.

IP issues (H323/SIP)
Commands in bold
e Open the Web GUI, go to Events > H.323 / SIP log and then click .
Important: For all logging, always delete old logs first by click before making any
testing call.
¢ Reproduce the exact issue that you would like the support team to troubleshoot for example,
by dialing from the endpoint to the TelePresence MCU or IP/ISDN Gateway.
Important: It is essential for any H.323 or SIP log to show the initial connection being
established between the endpoint and the TelePresence MCU or IP/ISDN Gateway, because
the negotiation which happens at this stage explains the behavior of the two devices later on
in the call. An H.323 or SIP log started part-way through an established call is not useful for
troubleshooting.

e After the issue has been reproduced, click on the H.323 log page.

e Onthe H.323 log page, click .
Save the resulting XML file then attach file to the ticket — Remember to name these or include
a description and compress multiple attachments into one file.

Event log and Event Capture Filter
e If calls are not completing or dropping straight away, obtain an event log with following
“Capture Filter” settings:
— Connection, dialplan, dspapi, H.320 and ISDN set to
logging level
—  The rest of the options should be left as logging
level
e If calls are connecting but not completing/ issues with codec negotiations etc.:
— BASsetto logging level
— Connection, dialplan, dspapi, H.320 and ISDN set to
logging level
— The rest of the options should be left as logging
level
e If ISDN Layers are not coming up:
— For ISDN GW 3200:
+ ISDN set to “Errors, warnings and trace” logging level
* NAT set to “Detailed trace” logging level
» The rest of the options should be “Errors, warnings and information” left as
logging level
— For ISDN GW 3201:
» ISDN set to “Errors, warnings and trace” logging level
+ ISDN-Q921 set to “Detailed trace” logging level
» The rest of the options should be “Errors, warnings and information” left as
logging level
Important: always place single call when retrieving the log and delete any previous logs.

Important: revert back to default logging level after the test.




How to capture a log from TelePresence MCU and IP/ISDN Gateway

Logs required for diagnostic/analysis
Below log should include on initial incident support request on each products and scenario.

Required Logs
Reported Problem configurati | Event | H.323 | Screen | diagnos | serial :::::’:
on.xml Log Log shot tic file log (s requett)
Reboot X x »
Call setup (simple case) x X x
c:::':‘ Call setup ([complex case) x x ® x
Audio [ Video x X x X X
Network problems X X X X
Reboot X X X
Codian Call setup (simple case) X b
1SoN Call setup [complex case) X X ® X
aw Audio [ Video x X x X x
Network problems X X
Reboot ® X x
Call setup (simple case) X X X
(l;z\:rn Call setup [complex case) X X x x
Audio / Video x X X X X
Network problems x * %

Reboot Issue
e Open the Web GUI, and login as “admin” user
¢ Download Diagnostic information log.
= Prior to MCU 4.0 and ISDN Gateway 2.0 Software release:
go to Home and then click Diagnostic information

Administrator options

® Systemn status

® Systemn settings

® iew an nfigur nferences
® Confiqure user accounts

® Update user profile

® cConfigure conference endpoints
® Confiqure gateways

® View event log

. nfigure network

® Update systern software

® Streaming-only interface

Click Download as text and decide on a folder for the file.
= MCU 4.0 and ISDN Gateway 2.0 or newer software release:
The diagnostic file can be download with the download button locates at Status-
>General page.
go to Status > General then click Download diagnostic information

Home Network Settings St ng Conferences Users Endpoints Gateways Log out Logs Help
Gatekaepe
Hormne > Status > General
.
i)
Goneral Confarences Haalth Security

Model Codian MCU 4215
Serial nurnber MRVIS01SM000318
Software varsion 4.0(1.54)
Build 6.15(1.54)
Uptima 4 hours, 14 minutes, 56 seconds
Host name MCU4215.APAC
IF address 10.85.32.60

CPU load 0.5%
Medis ing load 896 (vid « audi o}

Current time 18:32, April 7 2010
Haw tima

15:59:59.00 01/01/70 - Unk
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How to capture a log from TelePresence MCU and IP/ISDN Gateway

Take snapshot of system status information page Status > General

Network

Settings Conferences Users Endpoints Gatevays Gatekeeper

@ Conferences Health
System log

15:34:46.00 19,/03/09 - User requested shutdown
15:29:51.00 19/03/09 - User requested upgrade
13:23:03.00 14/03/09 - Unknown

23:59:59.00 21/12/69 - Unknown

Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file.

Sniffer the packet on TelePresence MCU or IP/ISDN Gateway
Note: This method should only use when request by TelePresence TAC.

Note: Require 2.4 or newer released software on MCU.

Important: This works on both H.323 and SIP call, however it must disable encryption. For SIP,
make sure not to use TLS for signaling.

Important: Make sure to have compact flash card in the TelePresence MCU or ISDN/IP Gateway
Products external slot.

Commands in bold

Open the console session
for Port A sniffer ( for 8510 MCU Blade)
or

for Port B sniffer

# MCU 4520 - HyperTerminal
Ele [dt View Cal Jransfer Help
D& &3 0B &

Hit CTRL-C to break
“CMCU:>
HCU:>

K]

Connected 00:18:26 Atodetect  TCPIP

Make a call and keep running until you have recreated the problem
to stop

Download Sniffer log

=  Prior to MCU 4.0 and ISDN Gateway 2.0 Software release:

User must download the network capture file with FTP Go to the web interface and
then new link called is now available in top home
page.
Administrator options

System status

Systern settings

View and configure conferences
Confiqure user accounts
Update user profile

Configure conference endpoints

Configure gateways
View event log

(LR R R NN RN

LR 3

Configure natwork
Update svstern software

Streaming-only interface

.

= MCU 4.0 and ISDN Gateway 2.0 or newer software release:
User must download the network capture file with FTP directly from Hardware.
Click this link to download the file.
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How to capture a log from TelePresence MCU and IP/ISDN Gateway

e Attach file to the ticket — Remember to name these or include a description and compress

multiple attachments into one file.
Note: You may download capture file by using FTP application as well

Reset Password on TelePresence MCU or IP/ISDN Gateway
Note: This method work for

e MCU with 2.1(1) or newer released version (till prior to 4.0 release)

e IPVCR with 2.1(1) or newer released version

o ISDN Gateway with 1.3(1.1) or newer released version (till prior to 2.0 release)
Commands in bold

e Open the console session

& COMB:3B400baud - Tera Term VT
File Edt Setup Control Window Help

MCU:> reset_password
1 Ha.sswnrd reset
CU:=>

o After executing this command Administrator account comes to default.
User name: admin, and no password.
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How to upgrade TelePresence MCU and
IP/ISDN Gateway

This chapter explains how to upgrade TelePresence MCU and IP/ISDN Gateway by using ftp software
or Compact Flash Card for in case of problem with upgrading software from WebGUI or TMS.

Upgrade software by using FTP software
Commands in bold
e Open Command prompt (may use any FTP client software)
e Change the directory, if necessary by using “cd” command
For example, software folder locates under C drive on PC, then

[ ]
o Type in “User:”
e Type password in “Password:” Default password is TANDBERG unless changed.
« CAWINDOWS\system32\cmd.exe - fip 10.81.11.25 - 0] x
<] v
[ ]
[ ]
. (or )
For example,
=+ Command Prompt
cuments and Settings\Dharmesh.nandoria’cd™
C:~>fFtp 10.91.8.2808
wmected to 10.91. .
A Welco to the HCU 4585, version 2.4¢1.28>
e € 91.8.2080 : admin
ord regu
» 2.4¢1.28> uploaded
n 182.615econds 349.3
[ ]




How to upgrade TelePresence MCU and IP/ISDN Gateway

Reboot the MCU manually from Web GUI, from telnet session, etc.

3 Codian MCL - Shut down unit - Mazilla Firefox =13
Ele [ Yew Hgtory Qookmarks Jook  Help

G - " 1 | hitpa 10,51 8. 200 settings,_shutdown. hisel =iy -| |G- 4
il Most visited || Windows Markatgiace | | ] woel2

3 copeemic - » | & @ SearchWeb = B SearchDedltop: Al = &

| Codian MU - Shist down uni B | | Tarkerg nowledge basse

COdICJh

Home  Gtaty

MCL software upgrade status in progress, 5811K
aidar uparade status Supgrade not sttemgted >
parstional statup Acthes - Unit must ba shit down bafors restart

|| Stuit down MCU

(<) Copyight Cadisn 2003-2008. Lisanys mfurmation

Upgrade software by using Compact Flash Card

Extract the image from the .zip file to your hard drive and rename the extracted image to
kupgrade.

Obtain a Compact Flash card of between 32 and 256 Mb capacity, and some means of writing
to it. USB compact flash card reader/writers are readily available.

Copy kupgrade on to the Compact Flash card.

Connect a serial terminal to the Console port of your unit using the connection settings on the
unit's back label.

Insert the Compact Flash card in to the slot on the unit's front panel and shutdown/restart the
unit from the web interface.

Watch the output on the serial terminal.

After a few seconds, you will see several rows of '....." appear, followed by a message telling
you the number of bytes copied. This represents the copying of the kupgrade image from the
external Compact Flash card to the unit's internal memory.

After you get message “ bytes copied “Eject the Compact Flash card from the external slot.

B COM9:38400baud - Tera Term VT
Fh ;& Setup  Control wr\dm- Help

.B227d1%a bytes copied

loade ine
loadelf line 86 ~

The unit will complete the upgrade process and reboot of its own accord.

Important: If flash card is not removed then after reboot it will start upgrade process again.
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How to capture a log from MPS series

Important: Please start the log capture from all systems involved in the call before calls/conferences
are started so we capture all the call setup process and ensure that all output is logged to a file so
none is lost.

This chapter explains how to capture the complete log file available for MPS series. The table below
lists the commands needed for the MPS series. Please type all commands in the same Telnet
session.

All retrieved logs should attach to ticket including a description and compress multiple attachments
into one file.

IP issue (H323/SIP)
Commands in bold

Open the console/telnet/ssh session with MPS

Make a call and keep running until you have recreated the problem
, if issue related to video/audio channel status etc.
Don't worry that the screen is scrolling, just type in and press return to retrieve system status

log
Hang up call

Don't worry that the screen is scrolling, just type in and press return to turn off logging
Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file

ISDN issue
Commands in bold

Open the console/telnet/ssh session with MPS

Make a call and keep running until you have recreated the problem
, if issue related to video/audio channel status etc.
Don't worry that the screen is scrolling, just type in and press return to retrieve system status
log
Hang up call

Don't worry that the screen is scrolling, just type in and press return to turn off logging

Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file

Reboot Issue
Commands in bold

Open the WIinSCP session with MPS
Login as “root” user




How to capture a log from MPS series

e Please do not open this folder. Simply drag it to your desktop, zip it and attached

[ ™y
WInSCP Login ‘QI X I
Session Session
Stored sessions Host nama: o —
Environment
Directories 19216801| 22 12
S5H
Preferences User name: F_'assmd;
root *00 0
Private key file:
Protocol
File protocot: SCP -
Select color
[ Advanced options
[Ml_Jletuau] [Lm J[SM_JIM ]
.

Following error message below may appear during the connection process, but please click
“ok” and processed.

[ ok ][ More >> ]

Retrieving the entire log folder “log” under /tandberg directog.

ticket — Remember to name these or include a description.

Default factory MPS
Commands in bold

Open the console/telnet/ssh session with MPS
Take backup of system configuration and option keys
xCommand DefaultValuesSet Level:3

%

By Intel - root - WinSCP = ®
Local Mark Fles Commands Session Options Remote Help
-] #H- P Ee ES BRE Il Default - 8-
& System L8R R G0 [ | % | U rendberg L | maEaE
Name  Ext Sze Type Changed 4 | Name  Ext Sze  Changed Rights
%[ Parent direct...  &/9/2010... t. 12/5/7010 8:...  rwaerx
|. Extremedraphics I7AIb P G9010... 12/5/2000 81 1WKeeeee
). Logs IPA T &92010. L0/B/2008 12 PWAesweee
i terminfo 12/5/2010 8:...  rwoorwTwx.
. app L1/17/2010 L., rwsr-Xr-x
L certs L1/T2/I010 6., rwser-xrx
)i crash 12/5/2010 81...  rwsorwxrwe
J. directorypolicy 12/5/2010 8:...  rwoer-xr-x
- 12/5/2010 8:... nweer-xr-x
., images 12/5/2010 8:...  rwoer-XT-X
b 11/22/2010 5...  rwoer-xr-x
)i log 12/5/2000 8.,  rwoer-xr-x
). lost+found 12/5/2010 8:...  PWOGswese
). management 12/5/2010 8:...  nweer-xr-x
. persistent 1/26/2011 10... rwoorwT-X
J: provisioning 11/19/2010 6., rwner-xr-x
). provey-registration /62009 7:1...  rweer-wr-x
L thl 1212000 4:,,,  rwer-xrx
OBof0Bn 0oft 0B or5365 Bin 0of3l
p Cf F7 Creste Directory » AL F10 Quit
8 s et

Reset Password on MPS Connect serial/console connection

Restart the MPS

Login with the user name PWREC. No password is required.

You will be prompted for a new password.

file to the
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How to capture a log from MPS series

B COMB:115200baud - Tera Term VT

Ble Edt Jetup Control Window Help

ANDBERG BC login: PWREC
ncgléagﬂ%m"!l?b. ¥OU WILL BE PROMPTED FOR A PASSWORD TWICE
LEASE RETYPE PASSWORD:

E
ANDBERG BORDER CONTROLLER RELEASE Q5.2
a RELEASE DATE: 2087-06-22

K

RITING PASSWORDE THROUGH TAMDBERG APPLICATION FAlLED.
ESTORING PASSWORDE TO PASSWORD FILE DIRECTLY. TO ALLOW
ANUAL RECOUERY PROCESS.

TANDBERG BC login:

Note: The PWREC account is only active for one minute following a restart. Beyond that time you
will have to restart the system again to change the password. Because access to the serial port
allows the password to be reset, it is recommended that you install the MPS in a physically secure

environment.
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How to upgrade MPS series

This chapter explains how to upgrade MPS series by using scp software for in case of problem with
upgrading software from WebGUI or TMS.

Commands in bold

Open the console/telnet/ssh session with MPS
Login MPS as “root” user
Set new release key by to /tmp folder
(XXXXXXXXXXXXXXXX iS hew release key)

copy (upload) new software to MPS under /tmp folder by using SCP/PSCP application.

or

Note: SW file name should rename to “tabasco-image.tar.gz” before upload it to /tmp.

Note: Upgrade will automatically start once SW file upload completely. However if the upgrade
did not start immediately, by executing following command will start sw upgrade immediately.

Wait until the software has installed completely
Reboot the MPS manually from Web GUI, from telnet session, etc.

Note: You may use WinSCP application for entire this process including setting up release-
key file as well.




How to capture a log from Classic MCU/ISDN
Gateway

Important: Please start the log capture from all systems involved in the call before calls/conferences
are started so we capture all the call setup process and ensure that all output is logged to a file so
none is lost.

This chapter explains how to capture the complete log file available for Classic MCU and Classic ISDN
Gateway. The table below lists the commands needed for the Classic MCU and Classic ISDN
Gateway. Please type all commands in the same Telnet session.

All retrieved logs should attach to ticket including a description and compress multiple attachments
into one file.

IP issue (H323)
Commands in bold
Open the console/telnet session with MCU/GW

Make a call and keep running until you have recreated the problem
, if issue related to video/audio channel status etc.
Don't worry that the screen is scrolling, just type in and press return to retrieve system status
log
. , if issue related to video/audio channel status etc.
Don't worry that the screen is scrolling, just type in and press return to retrieve system status
log
e Hang up call

Don't worry that the screen is scrolling, just type in and press return to turn off logging
e Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file

ISDN issue
Commands in bold
Open the console/telnet session with MCU/GW

Make a call and keep running until you have recreated the problem
, if issue related to video/audio channel status etc.
Don't worry that the screen is scrolling, just type in and press return to retrieve system status
log
. , if issue related to video/audio channel status etc.
Don't worry that the screen is scrolling, just type in and press return to retrieve system status
log
e Hang up call




Don't worry that the screen is scrolling, just type in and press return to turn off logging

Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file

Reboot Issue
Commands in bold
e After codec restart open the console/telnet/ssh session with MCU/GW
[ ]
or

Download event. log file from root directory of MCU/GW
Open Command prompt (and change home directory, if necessary)

Default password is TANDBERG unless changed. Please enter any user name (e.g. admin)
as login name.

The event. log file transfer to directory of Command Prompt specified.
Attach file to the ticket — Remember to name these or include a description and compress
multiple attachments into one file

Default factory Classic MCU/ISDN Gateway

Commands in bold
Open the console/telnet/ssh session with MCU/ISDN GW
Take backup of system configuration and option keys

or

Open the console session with codec by using RS232 cable
Take backup of system configuration and option keys
Restart codec and break the boot sequence

(for hyper terminal), or (for TeraTerm/Putty)
“$” prompt will feedback

B COMB:9600baud - Tera Term VT

Ele Edt St Contrd Window el

64N
: 64NMB
_B: BA:5@:6R:A2:CE:SE
: Caore version Bx8882. Core revision Bx2814
Partnum Bxa. Masknum Bx18. Microcode B8x71

MCU/GW will automatically restart




How to upgrade Classic MCU/ISDN Gateway

This chapter explains how to upgrade Classic MCU/ISDN Gateway by using ftp software for in case of
problem with upgrading software from WebGUI or TMS.

Commands in bold
e Open Command prompt
e Change the directory, if necessary by using “cd” command
For example, software folder locates under C drive on PC, then

o Type software Release Key in “User:”
o Type password in “Password:”. Default password is TANDBERG unless changed.

«r C:AWINDOWS\system32\cmd.exe - ftp 10.81.11.25 -0 x

o (or )
For example,
e Wait for completion of file transfer.
e C:AWINDOWS\system32\cmd.exe - ftp 10.81,.11.25

e Reboot the MCU manually from Web GUI, from telnet session, etc.




How to capture a log from TelePresence Management Suite

How to capture a log from TelePresence
Management Suite

This chapter explains how to capture the complete log file available for TelePresence Management
Suite logs, Provisioning Directory logs files, and Windows server logs. Also provide additional

faultfinding information
All retrieved logs should attach to ticket including a description and compress multiple attachments

into one file.

Log from TelePresence Management Suite
e For TMS 12.1 or older version, log files can be found on the TMS server at the following
location: C:\Program Files\TANDBERG\TMS\wwwTMS\Data\Logs\tmsdebug
e For TMS 12.2 or newer version, log files can be found at (and download from) TMS

Administrator Tools.
To take TMS logs : Go to Administrative tools — TMS Server maintenance — Download
logs — Logs will be download in zip format attach this logs to ticket.

%) TMS > Administrative Tools > TMS Server Maintenance - Mozilla Firefox
Fie Edt View History Bookmarks Tools Help
@ - C X @ ¥ (& hupinossss fdef st pageld=114 B - |G- / u -
, 18] Most visted | '] Windows Marketplace | | ] week2
|1 RK generator il 5C. Look-up || TANDEERG Knowledge Base <Ex TMS > Administrative Tools > T... B -
TANDBERG Management Suite 2
Bt} Potal 4 B g & g Lk I'T) Phone Books & Reporting 2 (Y od
TMS Server Maintenance Configuration *  [inistrative Tools * TMS Server Maintenance

Database Server Date and Time Settings User Administration . =

712872009 1:38:21 PM Lacatdns

TrZAZ009 1: 3521 PM Billing Codes
0 days, 0 hours, 0 minutes and 0 seconds

Activity Status

TS Clagnaatics TMS Server Maintenance ~

C-h:k'lwl)ownbndLou Files® button to create and download o disgnostics Zip file 1o assist Technical Support with troublesho, TMS Tickets ted will contain the recent TMS debug log
0 rrotJi4S"s configuration seiftings and any TMS relaled entries found in the Windows application event log.

Audit Log

Database Server Disk Space

TMS Server Disk Space

Database Fies and Size info
Database Maintenance

Purge Old Data in Database Tables Flan
Purge Log Plan

TMS Services Status

TMS Servers

6] 163 JED] K] [ WD (€D >

| Retresh |

APAC P (T 2\.]'1m.nn trador) System Contact: Tommy Lee Server Tme 0207 PNI SlN sz:amoz Verwx 1‘2 2

_ “ﬂ._ ey SR it Ty Loe. —— &

e The TMS Provisioning Directory Logs, logs TMS provides for Provisioning Directory can be
found on the TMS server at the following location:
C:\Program Files\TANDBERG\TMS\wwwTMS\Data\Logs\tmsdebug
The name of the log files that you will want to look at with regards to the Provisioning
Directory are as follows:
o log-provisioning.txt
o log-provisioningproxy.txt
o log-provisioningservice.txt

Log from Windows server
o The log files can be found on the server that TMS server is running by using Event Viewer
function.
o To take Windows Server logs : Go to Start > Administrator Tools & Event Viewer

Cisco TelePresence Solution Support — TelePresence Infrastructure Handbook Page 37 of 42



How to capture a log from TelePresence Management Suite

._!WVWSW j""‘rw& %TT

» @ Component Services

= Computer Management

4 Configure Your Server Wizard
2 Data Sources (0DBC)
Dictributed File System

¥ Intemet Information Services (I15) Manager
& Licensing

5 Local Security Policy

§ Manage Your Server

$n Microsoft .NET Framewark 1.1 Configuration
e Microsoft .NET Framework 1,1 Wizards

@ Netvork Load Balancing Mansg

P Network Monitor

¥ Performance

(22 Remote Desktops

= Routing and Remote Access

68y Services

Loooff mwm B Terminal Server Licensing

B Tarminal Saruirar Fanfin wshon

e The name of the log files that you will want to look at:
o Application
o System
o TANDBERG

Important: Save the logs as .evt format only.

B Event Viewer
Ele Action Yiew Help
- | A0 EFOR R E OpenlogFie..
(50 Event Viewer (Loca) Application 6,084 event(s) ey SavelogFieds.. |3 E
]| Application Tyoe S 2 e _'
E ::E::: :'_\_E)Iréumaum 5:06:12AM  Scech ..?Q
3] Internet Explorer @information  8/9/2009 LO0:14PM  SceCh g
V1| TANDEERG B information  8/8/2009 8:48:15PM  SceCli &
Dinformation  8/8/2009 3:38:18AM  SceCh &
B information  §/7/2009 11:33:42... OpenDS @&
Dirformation  8/7/2009 11:33:38 ... TMSProvisioningService| G
@ Information  8/7/2009 11:33:24... COM+ G
@information  8/7/2009 11:31:59... TMSLiveService "::
Dinformation  8/7/2009 11:30:58 ... MSSQLESQLTMS b
& Failure Audit  8/7/2009 11:30:58 ... MSSQLESQLTMS e
@) Information  8/7/2009 11:30:58 ... TMSBackgroundService! I,
(S Failure Audit  8/7/2009 11:30:58 ... MSSQLESQLTMS (4)
) Failure Audit  8/7/2009 11:30:57 ... MSSQLESQLTMS (@)
(B Information  8/7/2009 11:30:57 ... vmktools Mo
@ information  8/7/2009 11:30:57 ...  TMSSchedulerService Not
Binformation  §/7/2009 11:30:57 ... TMSSchedulerService Mot
@ Information  8/7/2009 11:30:56 ... TMSProvisioningService  Not
A ool Ll_l
[ [

Log from TelePresence Management Suite components and faultfinding
Main TelePresence Management Suite components and faultfinding method:
a) TMSDatabaseScannerService

o Whatit does:
This service will check the connection status, the call status and the system
configuration of existing systems on a user defined intervals.

o Symptoms:
The system information and system status in TMS is outdated.

o How to fix:
- Restart the service, if that doesn’t work restart the server.
- Logs are found in \tmsdebug\log-TMSDatabaseScanner.txt
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b) TMSLiveService

o What it does:
This service will set up launch and monitor a scheduled conference

o Symptoms:
The call does not start and the log in Conference Control Center is almost empty

o How to fix:
- Restart the service, if that doesn’t work restart the server.
- Logs are found in \tmsdebug\log-liveservice.txt

c) TMSPLCMDirectoryService

o What it does:
This service is responsible for posting phonebooks to Polycom endpoints

o Symptoms:
You don’t get any phonebooks on you Polycom endpoint

o How to fix:
- Restart the service, if that doesn’t work restart the server.
- Logs are found in \tmsdebug\log-plcmdir.txt

d) TMSSchedulerService

o What it does:
This service is responsible for launching events at set times. Events like system
restore, system upgrade, call launch

o Symptoms:
Scheduled events do not start

o How to fix:
- Restart the service, if that doesn’t work restart the server.
- Logs are found in c:\tmsdebug\log-schedulerservice.ixt

e) TMS Snmp Service

o What it does:
This service is collecting traps from the endpoints and is putting them directly into
the database. It is also responsible for broadcasting SNMP messages to discover
newly added systems.

o Symptoms:
The statistics are empty

o How to fix:
- Restart the service, if that doesn’t work restart the server.
- Logs are found in \tmsdebug\log-watchdog.txt

f)  TMSProvisioningService

o What it does:
This service starts the local TMS-Agents and it is needed for provisioning

o Symptoms:
Unable to create or edit groups or users within TMS on page Systems > Provisioning
> Directory

o How to fix:
- Restart the service, if that doesn’t work restart the server.
- Logs are found in \tmsdebug\log-provisioningservice.txt




Phonebook (Corporate Directory) Common Errors
Common errors which may see with Phonebook service on TelePresence Management Suite.
May see following errors on the endpoint if corporate directory is not working properly:

Message

Explanation or Suggested Solution

Request timed out, no
response

The TMS server is busy, try again.

Warning: directory data not
retrieved: 404

The endpoint is configured with the IP address of a
different web server than the TMS server.
The corporate directory path on the endpoint is wrong.

Warning: directory data not
retrieved: 401

The “Public” virtual directory on the TMS server is NOT
configured to allow Anonymous Access.

The most common problem here is that anonymous
access is set but the account used has been overwritten
by a group policy. The default IUSR user is a part of the
guest account and typically group policies disable this
account.

TMS: No phonebook(s) set
on this system

No phonebook(s) set on this system in TMS. Configure
the endpoint to subscribe to phonebooks in TMS.
Using NAT on the endpoint can lead to TMS not
recognizing the system and will not allow it to retrieve
any phone books.

Request timed out, no
response

The endpoint is configured with the IP address of a non
existing web server.

No contact with server

The IS is restarting or in a state where corrupted
messages are received.

Upgrading from a previous TelePresence Management Suite version

Upgrading of the TelePresence Management Suite software itself is handled automatically by
the TelePresence Management Suite installer. Some additional steps may be required to
complete the upgrade depending on the previous version used.

Important: For detail please refer to the installation guide or the version specific Upgrade
Notes

Security patch for TelePresence Management Suite Server Appliance

Cisco will release a patch specifically for the Server Appliance within one calendar week of
Microsoft’s patch release. This file will only include relevant patches that need to be applied to
the Server Appliance to patch the components the system uses to achieve the Cisco specific
functionality. All patches released from Cisco are tested to ensure there are not effects on
functionality from the Server Appliance.

Please visit the following link for more detail information:
http://www.tandberg.com/support/video-conferencing-security.jsp

Compatibility with existing Integration Portfolios

TelePresence Management Suite Integration Compatibility matrix for TMS12.6.x and
TMS13.0:

Product C%rgﬁ)seilgr?le
TANDBERG See&Share Version 3.3
TelePresence Management Suite Microsoft Exchange Integration All Version
TelePresence Management Suite Microsoft LCS Integration All Version
TelePresence Management Suite Conferencing Extensions All Version
TelePresence Management Suite — IBM Lotus Notes Integration All Version




TelePresence Management Suite — IBM Louts Sametime Integration All Version

TelePresence Management Suite Movi for IBM Louts Sametime All Version

TelePresence Management Suite 3™ Party Booking API All Version

Uninstall TelePresence Management Suite

Uninstalling TMS will remove the TMS application, website, and services. It will leave any
customer data, logs, databases and database servers intact for use in future upgrades. If
you wish to completely remove all TMS information from the server, please refer to
installation guide for more details.

Uninstalling the TMS Application:

Start the uninstall wizard by selecting ‘Uninstall TMS’ from the TANDBERG Program Group
in the Start Menu or by using Add/Remove Programs under the Windows Control Panel.

Useful TelePresence Management Suite Related Document References
Most of the documents below can be found in the TelePresence Management Suite Software package

Software Release Note

Installation and Getting Started

Administrator Guide

Product Support Document

Redundancy Configuration and Overview (Fail-over or redundancy setup)

Secure Server for TMS (Hardening Win 2003 server)

TANDBERG Secure Management (Secure communication on TANDBERG products)
3rd Party Booking API (For programmer references)
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